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preface to 2nd english edition 

What was once simply Navision, became Navision Financials 
which became Navision Attain, then Microsoft Navision and is 
today called Microsoft Dynamics NAV. What is important to the 
loyal owner or user is that the ERP world behind the changing 
name is the same excellent quality they have come to trust. The 
newest version, Microsoft Dynamics NAV, is a continuation of 
this tradition of quality. This book is intended to serve compa-
nies and individuals using a wide range of versions within the 
Navision tradition. Therefore, the authors concentrate on the 
more essential deep features and concepts that remain largely 
unchanged despite the uneasy reality of shifting product names.   

Following the adage, “Teach a boy to fish and he’ll feed his fam-
ily for a life time,” the authors have developed examples that 
strengthen the reader’s intuition, encouraging him or her to think 
deeply about the system so that they have the confidence and 
tools to strike out on their own and explore the endless oppor-
tunities for optimization made possible through Microsoft Dy-
namics NAV. Whether or not you master the coding techniques 
covered in this book, you will become a better judge of the qual-
ity of others’ work. As you probably already know, the ERP sys-
tem is the heart of your enterprise, and therefore, you should not 
trust just anyone to do open-heart surgery on it. This book will 
help you develop a vision for successfully administering an ERP 
implementation even if you do none of the programming and 
physical implementation yourself. 

Readers are invited to contact the authors directly via email at: 
pdiffenderfer@yahoo.com, if more specific Microsoft Dynamics 
NAV assistance—not otherwise covered in this book—is needed. 
Likewise, mention must be made of the best source for Microsoft 
Dynamics NAV online help, www.mibuso.com. Thanks MIBUSO 
for getting us all—professionals as well as amateurs—out of the 
odd, technical quandary! 

Special thanks to Jill L. Keehner for the intense editing she did to 
improve this book—the 2nd english edition of a book that has for 
too long straddled a precarious line of bilingual ambiguity. 

Paul Diffenderfer and Samir El-Assal 

February 2008, Frankfurt, Germany  
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preface to 1st english edition 

In the last year and a half, worldwide interest in the ERP solution 
Microsoft Navision has more than doubled—and with good rea-
son. Microsoft Navision already enjoyed a broad and solid utility 
when it was purchased by Microsoft in early 2002, and now with 
the leadership and resources of Microsoft this ERP solution has 
quickly and dramatically improved in new and promising areas.  
Microsoft Navision is truly a comprehensive solution to the com-
plex business information management and analysis problems 
experienced by medium to small-sized firms. Whether you are 
operating a production or merchandising firm or a purely ser-
vice-based establishment, Microsoft Navision has tools that can 
streamline and optimize your information infrastructure.  

This is the third edition of the successful book “Microsoft Nav-
ision optimiert einsetzen.” In this book the authors attempt to 
discuss some of these new technologies as well as continue to 
offer an introduction to Microsoft Navision’s deeper structure and 
programming conventions, which by and large have remained a 
stable and unchanged basis for the recent software develop-
ments.   

As ever, the reader is encouraged to test the examples while 
studying this book. It suggested that one make use also of the 
abundant reference resources included on the Microsoft Navision 
demonstration CD in PDF format as well as the software’s exten-
sive on-line help files. If you do not have a copy of this demon-
stration CD please contact your Microsoft Business Solutions 
Center or see www.mibuso.com and they will be able to supply 
this for you. 

The purpose of this book is to help the reader overcome the 
danger of becoming overwhelmed by the size and complexity of 
the software and its resources. Therefore this book will be an aid 
in building a sense of the important themes, themes that will de-
velop the right intuition in the reader and thus make her or him 
able to embark on successful self-instruction projects in the fu-
ture. Mastering Microsoft Navision use and development can be 
the key to giving your company the quality and efficiency that 
will win you and your firm a profitable and effective future. 

We wish to make a special note of thanks to a few individuals 
and organizations whose kind and expert help has been neces-
sary to bring this book to the public. 
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Firstly Dr. Reinald Klockenbusch whose excellent guidance and 
trust have been the origin and prime mover in Vieweg Fachver-
lag’s publication of the first and second edition of this book.  
Secondly a loud applause is due Sabine Thiele in her lightning 
fast and expert translation work done for both German editions. 

We would like to thank the team at TONACO GmbH for pa-
tience and dedication to ever further optimisation of their Micro-
soft Navision ERP system. The examples in this book are larger 
taken from a real and tough day in the life of TONACO GmbH. 
Also we wish to thank B.I.Team Softwareberatung for providing 
demonstration software as well as high quality and professional 
support.   

Paul Diffenderfer and Samir El-Assal 

Washington DC, May 2005 
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1 The ERP Philosophy  

One of the most important decisions your company can make is 
how it will measure and manage its performance. Without good 
fortune and hard work—not to mention investment—realizing 
this goal is difficult regardless of the size of your operation. For-
tunately you have purchased Microsoft Navision as well as the 
designer licenses needed to open and optimize its structure. 
Armed with Microsoft Navision’s development tools such as the 
Application Builder, Table Designer, and Report Designer you 
now have a flexible and powerful state-of-the-art business infor-
mation tool capable of managing and measuring your firm’s per-
formance. Next you need only the time and know-how to opti-
mize it, that is to put it into use and adapt it to your firm’s spe-
cific needs. With patience and a few key skills you can create the 
ultimate controlling, workflow optimization, and management 
system that will help make your firm the lean, mean and profit- 
making machine that you always envisioned.   

At the outset of this book we will provide some background 
about Microsoft Navision as a tool which requires a brief discus-
sion of the philosophy of Enterprise Resource Planning (ERP). 
Next we will look at some of the promises and dangers of ERP 
solutions. We discuss what strategies to take to avoid problems 
and what tools in Microsoft Navision are there to help you exe-
cute winning strategies, thus actualizing the promises of ERP.  

1.1 Promises of an ERP system 
First and foremost the ERP system is an information source. The 
information management must be quick, complete and correct. 
With these things in place, the ERP system promises you the 
ability to have every fact about your company’s past, present and 
future plans and expectations—in detail and in summary—at 
your finger tips. Because ERP systems bring the information of 
various departments together you enjoy the benefit of having a 
real-time overview of the entire firm. 

As the ERP system connects the information of each department 
it can enforce a single standard throughout your entire firm. This 

Interdepartmental 
Information fu-
sion 
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gives you a unique opportunity to ‘rationalize'  your company’s 
operations and have your corporate culture and vision reflected 
in the practices of each department. For example, if one of your 
business goals is to have same-day shipping you can set up your 
ERP system so that each department has information about the 
customer’s order even before it is their turn to work on it. This 
transparency of information allows each department to prepare 
for their part of the production process. It also facilitates com-
munication between departments, making it easier to avoid or 
find solutions to problems before the product has reached their 
department. In this way departmental barriers can be broken 
down by giving everyone access to the same relevant informa-
tion at the same time. This level of interdepartmental, informa-
tion fusion can bring tremendous efficiency to your shipping, in-
ventory, and customer order entry departments. 

The ERP system gives you the possibility of standardizing your 
business processes. For example, you can customize your ERP 
system to automatically print invoices at the moment the ship-
ping department prints the packaging documents so there is 
never the question whether the customer received an invoice 
without the matching shipping documents. Another example is 
having the system automatically suggest only those ingredients 
which have a certain critical shelf life to be used in production 
thus enforcing the uniform quality of your products. This stan-
dardization of your processes and operations allows you to 
measure your firm’s performance more accurately because you 
are receiving consistent information from your departments who 
are working in the same manner and with the same information.  

With improved standardization of information and processes the 
firm can train new workers more quickly. The optimized ERP 
system not only suggests to workers the next step in their task 
and informs them when dangerous or tricky actions are being 
undertaken, but also educates them about working in an orderly 
manner. By tailoring the system you can guide individual work-
ers within a specific workflow that optimizes the tasks and pro-
vides built-in clarity about the expectations of the job they are 
performing. In this way the whole firm can reach a higher level 
of performance and efficiency. 

The ERP system promises to optimize your company’s efficiency 
and some of the best tools designed towards this end are the 
planning tools. Imagine that in one table, for example, the buy-
ing department could see every product and every product’s 
components in open orders as well as their availability in the in-

Standardization 
of Operations 

Position training 
and optimization 

Planning tools 
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ventory. This information could save workers countless foot-
steps, not to mention endless back-and-forth questioning. The 
ERP system’s interdepartmental connections optimize project 
management and task coordination. Efficiency and costs can be 
saved as it will no longer be necessary to shuffle paper between 
departments or make frequent trips to the refer to the archives.  

Another advantage of the ERP solution—which integrates firm-
wide information—is that important aggregate variables (like To-
tal Sales or Total Freight Costs) are directly linked to the specific 
details of which the aggregate variables are summations. For ex-
ample, when looking at the Liquidity Analysis in the General 
Ledger matrix you can immediately drill down to individual un-
paid invoices that make up the accounts payable and see exactly 
which are the most expensive purchases contributing to the ac-
counts payable. Here you see that you do not have to sacrifice  
the everyday details to obtain a big picture of what’s happening. 
This type of capability gives the CEO an eagle’s-eye view with-
out losing touch with the individual, everyday decisions being 
made throughout the firm. 

Because of the interconnectedness of information the controller 
can cross-reference reports to check the consistency of the in-
formation recorded by each department. For example, the ac-
counts payable reported in the General Ledger must be the same 
amount as the sum of open invoices reported by the buying de-
partment. If it is not the same, there could have been a manual 
booking into the General Ledger Accounts Receivables. Whereas, 
General Ledger Accounts Receivables should only contain system 
bookings. In this way you can see the inconsistencies that would 
have remained hidden if not for this integrated information infra-
structure. Such things can easily be managed with a good ERP 
system. 

Finally, all these promises—when actualized—should add up to 
the improved manageability and performance of your entire en-
terprise. With an optimized Microsoft Navision ERP system you 
should be able to do easily with a small team what a few years 
ago would have required an army of expensive managers. 

1.2  The Potential Dangers of Implementing an ERP System 
You must keep in mind however, that without the proper mar-
riage between your firm and your ERP solution you may experi-
ence results that are quite opposite of the expected promises. It 
is no overnight task to have a detailed and systematically defined 

An overview with-
out losing the de-
tails 

Results of these 
advantages 
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understanding of how your firm operates day-to-day. You need 
to understand your business to the extent that you can then 
strictly structure it in a software environment. 

The worst possible result—one that in practice occurs all too of-
ten—is that your new ERP system decreases your firm’s effi-
ciency, frustrates your workers and gives confusing or simply in-
correct information. This is all on top of the fact that the software 
was an expensive investment. The reality is that an ERP system is 
extremely complex and sensitive. In the ERP/firm marriage much 
work is required to adapt the software so that it becomes a mir-
ror image of your ideal business processes.   

The more knowledge you have of your firm’s daily operations 
and the capabilities of the software, the fewer comprises will 
have to made between your information processing work and 
your firm’s general operation. While it is usually difficult to find 
both of these knowledge sets within the same person, it is the 
ideal to shoot for. 

As mentioned above, a common problem that ERP users run into 
is that the ERP system actually increases their workload and 
gives them false information. This failure occurs most frequently 
because ERP users do not have “clean” foundation information in 
the system. As a result, the system uses less than perfect informa-
tion to produce false results that must be endlessly corrected. 
When this happens you will hear workers complain about hav-
ing to continually “feed” this new and expensive tool—work that 
before was unnecessary. Sadly, this exact situation occurs in 
many firms. You MUST make an effort in the very beginning of 
your ERP installation to get your “stock” data nearly perfect. 
Your stock data constitutes the information that you use that 
rarely changes, such as chemical or product recipes or the ad-
dress or bank account of a customer. If you utilize incorrect 
stock data you will, from day one, generate new and automati-
cally false entries with each transaction that utilizes incorrect 
stock data. 

Let us consider an example that frequently occurs. Suppose there 
is a production firm that introduces Microsoft Navision as its first 
ERP system. Let us also suppose that the production manager of 
this firm has resisted the firm’s innovation and has failed to em-
brace, understand and manage the ERP project. In particular, he 
has failed to invest the time needed to make 100% sure that ba-
sic information has been correctly and completely entered into 
Microsoft Navision. Let us further suppose that both false and in-

Data entry and 
care 

Negative example 
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complete product recipes have been entered into the production 
module and that the ERP system uses these unapproved recipes 
in creating production orders. When these production orders are 
processed, the ERP system automatically eliminates false ingredi-
ents from the inventory and calculates false production costs 
along each step of the production process.  

Although the production manager has always orchestrated the 
production without recommendations from an information sys-
tem and feels no immediate pain from his poor management of 
the new system, his bad habits will be the source of problems 
for nearly the entire ERP system and all it users. This bad behav-
ior in one causes bad business decisions to be made, creates 
false inventories and late shipments. Pretty soon, the entire firm 
has lost faith in the ERP solution. This chain of problems occurs 
because: the system will not calculate the correct material costs 
of production; the system inventory will be incorrect because the 
system will not be properly accounting for what is being used in 
the production process; the buying, shipping and the order entry 
departments will not be able to trust their tools which are de-
pendent on correct inventory information, thus resulting in their 
inability to plan.   

On top of all these problems, someone must spend several hours 
each week correcting the system inventory (if they want the ERP 
system to function at all) until the source of the problem—the 
false recipes in this example—is corrected. The advantage of 
having an information system which integrates data from each 
department can quickly become a disadvantage if one depart-
ment fails to work cleanly. 

Another danger to be aware of is this: becoming overly-
dependent on outsourced programming. Such relationships can 
become a vicious circle because the programmers frequently 
write solutions in a manner that make them inflexible in the long 
run. It is better for the long-term future of your firm to have 
someone in-house who can accurately fine-tune your system. 
With a little knowledge of the background development tools 
and capabilities, you will be able to determine the difficulty of 
your various development needs and judge the quality of the 
specialists you hire. Imagine that you need to insert the informa-
tion of a second bank account so that it appears on your firm’s 
invoice. Such tasks (adding information to reports, documents or 
masks) are frequently required and are not dangerous or difficult 
to perform. Therefore, it may not be reasonable to hire an ex-

Out-sourcing   
programming 
work 
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pensive specialist when you could do the work yourself in min-
utes and get exactly the results you want.   

Let us consider the following example. You ask an outsourced 
programmer to set a default price group so that it is automati-
cally given for each new customer. Imagine that this default 
price group should be: STANDARD_CUSTOMER. To accomplish 
this simple task they simply program the default code, STAN-
DARD_CUSTOMER, into the customer table as a static and abso-
lute text that permanently assigns this price group to new cus-
tomers. The better way would have been for the programmer to 
create a new field, Default Price Group, in the price group table 
so that the user can—at any time—select a default price group. 
The first and inferior technique means that in the future, when 
you want to change the default, you will have to pay the pro-
grammer again to do with code what any user could have done 
themselves. An even worse outcome is when the option, STAN-
DARD_CUSTOMER, is erased from the price group table list. In 
this case, an error will occur stopping the creation of new cus-
tomers. The computer will try to assign the text, STAN-
DARD_CUSTOMER, even though this option has been erased 
from the price group table. The following cryptic error message 
will appear when a user tries to create a new customer: “Cus-
tomer price group code STANDARD_CUSTOMER does not exist.” 
Now it is impossible to create new customers until a “specialist” 
comes to fix the “problem“ unless someone in your company 
can interpret the error message. 

Later we will discuss in detail how you can make these kinds of 
simple changes yourself and protect yourself from potential 
emergencies invented by specialists who may be building future 
work for themselves into your system. 

An out-of-the-box ERP system like Microsoft Navision can be so 
flexible that if your firm is not careful, the plethora of options 
may foster chaos. Consider the following example: There is a 
standard price for each good in the product catalogue, however, 
this standard price applies to only the standard form and stan-
dard distribution of the good. Because of the tremendous com-
plexity of distribution in today’s firms, an ERP system like Micro-
soft Navision offers several, complex sales price methods. Below 
are some pricing options:  

 

 Price is linked to an individual product/customer relation-
ship  

Common-practice 
example 

Price flexibility 
versus chaos 
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 Price is linked to a customer group 

 Price is linked to a product group 

 Price is determined by discounting the standard price based 
on information in a third table which contains information 
about invoice discount  

 

This complexity goes on. If your firm fails to have a clear strate-
gy, it becomes difficult to find out where and on what level false 
price information has entered into a calculation.   

The ERP system is there to give the firm choices, but too many 
choices will lead to poor decision-making. The ERP system’s 
flexibility provides a variety of options for many types of firms, 
but in practice you should limit the standard functionality to 
neatly fit the operations of your firm. Therefore, although many 
possibilities exist in the software it is best to choose one strategy 
for performing a task and then block or hide (using the software 
development tools which we will discuss in detail later) the al-
ternatives. 

One of the biggest dangers of any software is that the firm will 
adapt to the software instead of the software adapting to the 
firm. In practice, the former happens quite often. It is frequently 
the case that because of a minor function or lack of a minor 
function in the software, the firm must change its workflow to 
follow an inefficient alternative just to support the larger interests 
of the software’s operation. Here is an actual example: To stop 
an order from being partially shipped before it is finished being 
entered into the system, the shipping department and the order 
department must work in shifts, which means that products can 
rarely be shipped in the same day. This absurdity occurs simply 
because the firm did not have the know-how and development 
tools to put a key into the software which distinguishes between 
“finished orders” and “orders not yet completely entered.” This 
book and the development tools within Microsoft Navision will 
help you to avoid some of these absurd situations.   

1.3 Strategies to Win the Promises and Avoid the Dangers  
Attitude: Never assume there is no better way of doing some-
thing. The key to success in optimizing your ERP solution is 
committing to a plan of continual improvement and fine-tuning.  
With Microsoft Navision and its development tools you have the 
perfect ERP platform for adapting an expansion ERP solution to 

Reducing the 
complexity 

Adapting ERP to 
your firm, & not 
the reverse 
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achieve all the promises previously stated and avoid the dangers 
that follow. 

The following steps are critical for attaining the goals of a suc-
cessful ERP solution: 

 

 Define your business operations clearly and concretely, in a 
logical if/then style 

 Define standard naming conventions and cataloguing con-
ventions 

 Gain control of the programmability of your software 

 

An effective way to begin defining the structure of your business  
operations is to use a good graphic workflow design tool like 
Microsoft Visio. With Visio you can quickly create diagrams that 
guide you along your path of program development to achieve 
solutions that will be easy to implement when you begin adapt-
ing your Microsoft Navision software. This book will suggest 
concepts and examples of techniques that will help you to real-
ize these workflow diagrams in the software. 

In addition to mapping your firm’s activities and familiarizing 
yourself with some development techniques, you will need con-
tinual support and feedback from your workers who must use 
the ERP on daily basis. It is helpful to foster a firmwide under-
standing that improvements require time, testing, feedback and 
training—a long but profitable process. This is the road to creat-
ing a truly comfortable and efficient information infrastructure 
that reflects the best intelligence of your firm.   

Einstein is supposed to have remarked, “Today’s problems were 
yesterday’s solutions.” Many times what you have used to meet 
the needs of one user will indirectly create a problem for an-
other. Due to the interconnectedness of a complex ERP software, 
it is always difficult to see how fixing a problem in one area will 
affect other seemingly distant functions in the software. This is 
why it is important to have a complete test version where you 
can check the effects of your new ideas (How to create a test 
version will be discussed in detail later). Everyone must work 
together to create the system that they will all be using together. 
As you move forward, have patience, because regardless of the 
promises of the ERP salesperson, no software can immediately—
out-of-the-box—optimize your firm. 

Prerequisites 

Feedback from 
your workers 
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Microsoft Navision is the winning ERP choice for small to mid-
sized companies looking to avoid the dangers and achieve the 
promises of the ERP philosophy. This is largely due to years of 
real world testing and continual improvement of the base Micro-
soft Navision software. The software is supported by a large 
network of experienced specialists who have helped more than 
15,000 firms with the installation and adaptation of the Microsoft 
Navision system. This is a history you can trust. However, it does 
not mean the software is perfect. As the needs of the business 
world change, so must the software. A tool as complex and 
powerful as an ERP system is like a living system—ever growing, 
changing and always offering new alternatives to outmoded 
practices. 

Microsoft Navision has out-of-the-box features that put tremen-
dously powerful and flexible information-gathering tools like 
Flow Filters—which eliminate the need of literally hundreds of 
special reports—at the user’s fingertips. 

Microsoft Navision’s powerful and intuitive application and func-
tion development environments make adapting as well as creat-
ing new fields, table views, forms and reports easy. If you are 
familiar with Microsoft Access, working in the Microsoft Navision 
environment will not be difficult. 

An important and powerful feature of Microsoft Navision is the 
ease with which you can create a fully operational copy or cop-
ies of your Microsoft Navision system. This is critical for testing  
Microsoft Navision functions or newly programmed applications 
or reports or tricky new techniques before integrating it into your 
firm’s precious Microsoft Navision database. A copy can also be 
a stress-free environment in which to learn about the Microsoft 
Navision system without the fear of making a mistake.   

Finally, with the help of this book, the extensive Microsoft Navi-
sion help files, documentation and the network of experienced 
specialists, you will have everything you need to optimize your 
installation of Microsoft Navision.  

 

Continuous-
improvement 
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2 Architecture, Login and Test System Creation  

In this chapter we will shed some light on the background of the 
Microsoft Navision system layout and show you how to locate, 
login and copy the Microsoft Navision database. 

2.1 Login 
In practice, most firms have one server, one Microsoft Navision 
database on that server and one company on that database. If 
you are using a single Microsoft Navision company, you can 
simply use the login window that appears automatically when 
Microsoft Navision is opened. You can forget about the back-
ground complexity of connecting to a specific server, database 
and Microsoft Navision company. The login window that auto-
matically appears only connects the user to the most recently ac-
cessed Microsoft Navision database and company. This is not the 
environment that you want to work in as you learn to master the 
Microsoft Navision environment. Therefore, we strongly rec-
ommend that you create a second database and use it as a test 
copy of your Microsoft Navision database. For this reason it is 
best to cancel your automatic login window so that you learn 
how to establish these connections manually.   

Logging in manually is more complex than the login you may be 
used to in other simpler software packages. The reason for this is 
that Microsoft Navision gives the user many options to choose 
from such as: whether to use a database located on the desktop 
client machine, use a database on a remote server and the choice 
of which Microsoft Navision company within each of these vari-
ous databases to use. Here is a diagram to help you visualize the 
Server/Client and Database/Company architecture: 

 

Manual Login 
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Figure 2.1  Server/Client & Database/Company architecture 

There are four steps to complete when you manually log onto 
your desired Microsoft Navision company:    

 

1. Whether to open Microsoft Navision’s Client version or 
Microsoft Navision’s Microsoft SQL Server version   

2. Choose the server where your desired database and Mi-
crosoft Navision company exist (this step is only neces-
sary if you have chosen to use the Microsoft Navision 
Microsoft SQL Server version in step 1) 

3. Enter your username and password 

4. Choose which company in the database you want to 
open   

 

The first step is to choose whether you want to use a database 
that is contained within your client PC (located on your client 
local hard-drive) or a database located on a remote sever. Nor-
mally, you will use the server edition of Microsoft Navision if 
you have a central Microsoft Navision database that is used si-
multaneously by many workers. In this book we discuss the Cli-
ent and MS SQL server editions of Microsoft Navision as they are 

To work locally or 
via the network? 
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the most common types of Microsoft Navision installations. 
These versions of the software are located at: 

 Start > Programs > Microsoft Business Solutions-
Microsoft Navision > Microsoft Business Solutions-
Microsoft Navision (for the client version) 

 Start > Programs > Microsoft Business Solutions > Mi-
crosoft Business Solutions-Microsoft Navision SQL 
server option (for the MSSQL version) 

Next, a Login window will appear where you enter your User ID 
and Password.   

 
Figure 2.2  Login window 

This Login window will automatically access the most recently 
used database and company which are recorded as ZUP-data in 
the client user information file. If you are using only one data-
base and one company in that database, you may always use this 
login window and forget the background connection it automati-
cally implies. However, we will be using at least two different 
databases in this book: your original “live” Microsoft Navision 
system and a test copy. Therefore, to choose the desired data-
base, first cancel the automatic Login window (if one has auto-
matically appeared) and go to:  

 File > Database > Open (you may have to repeat this step 
twice) 

Next, the following window will appear: (See Figure 2.3). 

First, you must choose your Server Name. In the client version, 
[Client Only] will appear. This is fine if your desired database is 
located locally on the client hard drive. We recommend that the 
original installation of Microsoft Navision and your Microsoft SQL 
server be set up by your solution center as these are activities 
performed only once and may require the experience of a spe-
cialist. Next, you must enter your User ID and Password before 
the server will allow you to enter anything into the Database 

Finding the right 
Microsoft Navision 
database 
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Name field. Choose which database you want to use and click 
OK. 

 

Figure 2.3  Open Database window  

Next, enter your User ID and Password and then click on the Da-
tabase Name field. 

A help arrow will appear in the white space of this field. Find 
the database you want to use and click OK. Next, you must 
choose which company in the database you want to work with.  
Go to: 

 File > Company > Open 

2.2 Creating a Microsoft Navision Test Database 
Now we will show you how to create a fully-operational copy of 
your Microsoft Navision system. 

2.2.1 The Benefits of Having a Test Copy   

You can attain the promise of adaptability and flexibility in your 
Microsoft Navision ERP system because it provides you with 
tools for copying and securing your firm’s active system. As you 
begin creating the information infrastructure that will literally 
mirror your firm, you will have to do a lot of testing and proceed 
by trial and error. These necessary development steps are risky 

Risk-
minimization 
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to test in your active Microsoft Navision system. Therefore, in the 
next section we will show you how to create a test version of 
your company’s Microsoft Navision ERP and eliminate all risks of 
trial and error development. 

Although it may seem like an advanced topic, it will be of great 
use to know at an early stage how to make a complete and 
working test copy of your active Microsoft Navision ERP system. 
After you have created a test version you can try the concepts 
discussed in this book in a familiar and safe Microsoft Navision 
environment.   

With a complete operational copy of your Microsoft Navision 
system you will enjoy many new conveniences. If you are going 
on a trip and want to take your company’s Microsoft Navision 
with you, simply install it on your laptop. You can also use the 
following techniques to create a security backup. A Microsoft 
Navision backup system for testing, learning and exploring will 
be critical in achieving your ERP goals, but is sadly a option that 
many firms fail to take advantage of. 

It is a good practice to test all new applications, reports, forms 
and methods in a fully-functional test copy of your firm’s Micro-
soft Navision system before copying and implementing them into 
your firm’s active system. Likewise, all outsourced programmers 
who work on your Microsoft Navision system should do so in a 
test copy before implementing their work into your active sys-
tem.   

We recommend that you create a client-based version test copy 
of the Microsoft Navision system as opposed to creating a test 
version on your server. A client-based test system is preferable 
for the following reasons: 

 A server-based copy may use precious server resources, 
causing too much network traffic which could decrease your 
network performance   

 A server-based copy could be logged onto by accident and 
used without the worker noticing they are not in the com-
pany’s “real” or active database  

 It may be a security risk while the copy contains all the 
company’s financial, customer, etc. information and may not 
have the security set up in exactly the way the company’s 
active Microsoft Navision database is set up   

... in an identical 
environment 

First test, then im-
plement 
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2.2.2 Learning About Your Database  

To help you visualize the following process, imagine that there 
are at least two layers to your Microsoft Navision system. There 
is the database itself which is like a shell within which you insert 
your company’s specific information. The first step is to create 
this “shell” and secondly to insert your company’s information 
into it. The “shell” must be big enough to hold your company’s 
mass of information. 

The first step in creating a copy of your company’s information 
is to assemble information about the database you wish to copy.  
After you have logged on and opened your desired Microsoft 
Navision database, go to: 

 File > Database > Information   

Here you will see general information about your Microsoft Nav-
ision database.   

 

Figure 2.4  Database Information window 

You will need to make a note concerning the size of the data-
base you wish to copy which can be seen in the Database Used 
(KB) field. You need this information to determine how large to 
make your new database as well as to know how much disk 
space is needed for the database backup. 
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Next, you must make sure that you alone are logged onto your 
desired database during the time you are creating a backup.  
You can do this by checking the second page of the Database 
Information window called Sessions. 

Here you will find the Current Sessions field. The number ‘1’ 
should appear in this field. If it does not, there are other users in 
the firm’s Microsoft Navision database which could disrupt your 
backup process. To find out who is “disrupting” the backup, 
click on the Current Sessions field and then on the arrow that 
appears in it. A detailed list will appear with all the Microsoft 
Navision activity taking place on your server at that moment.   

Make sure the users editing the data are logged off the system 
that you want to copy. If someone is working in the system 
while you are making a copy, you may lose the most current in-
formation, which means the copy will have errors in it. It is best 
to make your database backup in the evening when the network 
is not in use. To create the database backup you will need as 
much data storage space as the number of kilobytes indicated in 
the Database Used (KB) field. If you do not have enough storage 
space to work with both the database backup and the new data-
base on your local or server storage disk (2.2 times the size of 
the database size indicated in the Database Information win-
dow), then you can create your database backup and save it to a 
compact disc (CD). After your new database is created, import 
the database backup into your database from your CD.      

2.2.3 Creating the Backup Packet 

Continue by going to:  

 Tools > Backup…  

The following window will appear: 

Kick out other  
users when  
backingup!! 
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Figure 2.5  Database Backup window 

Select the Entire Database box as well as the other options 
shown in Figure 2.6. This ensures that a complete copy is made. 
Fill in the Description field. We suggest that you choose a nam-
ing convention for the new database. That said, the same name 
should then be used for the File Name field and later in the new 
database name. The name you choose should begin with the 
date on which the database backup was created. This date 
should be written with the year first, then the month and lastly 
the day. Using this method ensures that all backups and data-
bases will be sorted in chronological order on any file directory. 
The next part of your new database name should be: Microsoft 
Navision, then Test or Backup. Lastly, every word should be 
separated with an underscore (_).   

It is recommended throughout the book that you avoid the in-
clusion of empty spaces in the names of all objects and data 
names. Following this rule will make it easier to organize your 
data in the long run. Likewise, it will be easier to use your in-
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formation with other types of software which often have prob-
lems converting empty spaces. 

After filling in the Backup window click OK and wait until the 
message appears that tells you your Microsoft Navision backup 
was successfully created. This could take some time depending 
on the size of your database. 

Once you have created your database file you have a complete 
and compressed copy of your firm’s entire Microsoft Navision 
system and information, current up to the moment it was cre-
ated. Now you have a test version or security backup of your 
system. It is wise to make a database backup periodically and 
store it offsite—a step that could prove critical if something un-
foreseen were to happen to your firm or its information systems. 

2.2.4 Creating a New Database “Shell” and Installing Your Backup    

Let us continue creating the new test system. Completely close 
your network-based Microsoft Navision program and open the 
local version of Microsoft Navision located at: 

 Start > Programs > Microsoft Business Solutions-
Microsoft Navision > Microsoft Business Solutions-
Microsoft Navision   

Cancel any login window that comes up automatically, then go 
to:   

 File > Database > New 

The following window will appear: 

 
Figure 2.6  New Database window  

Notice the value written in the field, Licensed Size (KB). Micro-
soft Navision is designed so that everything the user does is lim-


